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USING THIS MANUAL 

Background information 

This manual contains installation and user information on WinTPC. Use this manual 
together with the Installation, Programming and Manager manuals of the control panel. 

The screens shown in this manual may differ slightly from those of your computer screen. 
Depending on whether you are running Windows 3.xx or Windows 95, there will be 
differences in screen layout, but in not program functionality.  The screens shown in the 
manual are for Windows 95. Some layout differences: 

Windows 3.xx Windows 95 

The title bar of your application differs: 

  

The drop-down menus in your application differ: 

  

Icons used in this manual 

The table below describes the icons used in this manual: 

Icons Description 

� 

A Note provides extra information which assists the reader in understanding 
the information. 

!  
An Attention draws the reader’s attention to important information. Ignoring 
this information could result in damage to equipment or loss of data.  
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ABOUT WINTPC 

Who should use this manual 

This manual is intended for three groups of users: 

• Managers 

Managers create profiles for users using Access. 

• Installers 

Installers have full access to the available menus and functions. 

• Users 

Users are the companies where the security system is installed. 

Purpose of WinTPC 

WinTPC has four purposes: 

• Remote connection to control panel 

• Easy programming of the control panel 

• Maintenance via log file 

• Display information on screen. 

Registering WinTPC 

You must register your copy of WinTPC in order to receive a copy of the Access for 
WinTPC program, which is needed by the manager of the system to change the program 
database. You will also receive the latest updated versions of the software as they 
become available. A separate registration sheet is included with the manual for you to 
return to our sales office. 

System requirements 

To ensure a flawless operation, make sure your computer meets the requirements shown 
below:
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Feature Minimum requirements 

Processor IBM PC 386 or higher 

Operating system Microsoft Windows 3.xx, Windows 95 or Windows 98 

Modem Transmission protocol CCITT V.21 or BELL 103 at 300 bps 

RAM 8 MB or higher 

Hard Disk space 10 MB of free disk space 

Disk drive 3.5-inch floppy drive 

INSTALLING THE SOFTWARE 

What files and programs are installed 

The installation program will install: 

• WinTPC 

• Borland database engine 

• Transport PC online help. 

Installing the software 

If you have WinTPC on floppies proceed as follows to install WinTPC: 

1. Insert the first floppy disk into the disk drive of your computer. 

2. Double-click ‘setup.exe’. 
- or -  
Select ‘Run’ from the Start menu and type ‘a:\setup.exe’. 

3. Follow the instructions that appear on your screen. 

 

If you have WinTPC on CD-ROM proceed as follows to install WinTPC: 

1. Insert the CD-ROM disk into the CD-ROM drive of your computer. 

2. If you have Windows 95 or above a start-up application is starting automatically. Under 
Windows 3.1 start startup.exe program from the CD-ROM root directory. 

3. To install WinTPC click “WinTPC” button on startup screen. 
- or -  
Select ‘Run’ from the Start menu and type ‘D:\Install\all\setup.exe’. Where D is a letter 
for your CD-ROM drive. 

4. Follow the instructions that appear on your screen. 
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Installing Access WinTPC 

Before you can use the WinTPC program, you must first have set up the Access for 
WinTPC program. This program allows you to change the information about users in the 
WinTPC database, and can only be used by the manager of the system.   
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STARTING WINTPC 

Logging on to WinTPC 

Proceed as follows to start WinTPC: 

1. Double-click the WinTPC icon   in your Transport PC program group. 
Your computer now starts WinTPC and initialises the modem. 
The logon window pops up: 

 

2. Enter your user name and password. 

3. Click ‘OK’. 

Logon troubleshooting 

• If the following window pops up: 

 

Cause Solution 

WinTPC cannot recognize your 
user name or password. 

Click ‘OK’ and re-enter your user name and 
password. 

• If the following window pops up: 
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Cause Solution 

The modem connection is not OK. Click ‘Yes’ to work offline, e.g. to prepare files for 
downloading or set modem configuration. 
- or - 
Click ‘No’ if you want to establish a connection. 
WinTPC will then shut down. 

Logging on as a different user 

Proceed as follows to log on as a different user while connected: 

1. Click the Logoff menu whether you are connected or not. 
‘Logoff’ automatically changes into ‘Logon’, but a connection, if any, remains online. 

2. Click the Logon menu. 
The following screen pops up: 

  

3. Enter another user name and password. 

4. Click ‘OK’. 
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QUICK TOUR OF THE TOOLBAR 

The table below describes the buttons on the toolbar of WinTPC: 

Button Description 

 

To open a previously saved ‘map’ file from your system. 

 

To save the current configuration to a ‘map’ file. 

 

To view one of a maximum of four status information windows of the online 
control panel. 

 

To edit panel settings of the control panel, online or offline. 

 

To arm one or more areas of the online control panel. 

 

To disarm one or more areas of the online control panel. 

 

To upload data from the online control panel. 

 

To download data onto the online control panel. 

 

To upload the engineer log from the online control panel. 

 

To view information on control panel, e.g. version, language, etc. 
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SPECIFYING THE MODEM SETTINGS  
OF THE CONTROL PANEL 

Proceed as follows to specify communication settings for the control panel: 

1. Make sure the modem has been connected to your computer properly. 

2. Select ‘Preferences’ from the Comm menu. The following window pops up: 

 

3. Specify the correct settings for the type of modem used: 

Setting Description 

COM port Select COM port 1,2,3 or 4. 

Baud rate Select Baud rate from drop-down list. 

Rings before auto answer Specify number of rings, before the dialler answers 
the incoming call. 

Carrier refresh Select ‘Normal’ or ‘Fast’ carrier refresh. 

Dial Select ‘Tone’ or ‘Pulse’. 

Init strings 1 to 3 Standard initialisation strings. Be careful when 
changing settings. Change B1 to B0 for CCITT. 
See also the user’s guide for the modem. 

Init string 4 For high-speed modems, try ‘ATN0S37=3’ to lock the 
modem speed at 300 Baud. 
See also the user’s guide for the modem. 

Dial type string See User’s Guide modem. 

4. When settings have been changed, a button ‘Save’ appears. 
Click the ‘Save’ button to save the new settings. 
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5. A dialog box pops up asking if the modem must be initialised with the new settings. 
Click ‘OK’ to confirm. 
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(DIS)CONNECTING TO (FROM) A CONTROL PANEL 

Different ways to connect a control panel 

RS232 connection 
The MPI has already been programmed with an Up/Download account number, and it has 
been powered up while dipswitch 6 is set to OFF. For more information, see also the MPI 
programming instructions.  

Using an RS232 serial cable, proceed as follows to connect a control panel with MPI: 

1. Select Preferences from the Comm menu and specify a COM port. 

2. Connect the RS232 serial cable to the COM port of your PC and to the 9-pin modem 
port of the MPI. 

3. Enter the U/D user code on the keypad. 
The MPI connects to the PC. 

4. Select ‘Answer’ from the Comm menu in WinTPC. 
 at the bottom of your screen indicates that you are connected to the control panel. 

‘Connect to line’ connection 
Before making a ‘Connect to line’ connection, the dialler has to be programmed with a 
U/D account telephone number. See also the RD62 programming manual. 

Proceed as follows to establish a ‘Connect to line’ connection: 

1. User selects ‘Connect to line’ from the Dialler menu on the keypad. 

2. Select ‘Answer’ from the Comm menu in WinTPC. 
The modem emits a tone. 

3. The user accepts ‘Connect to line’ in the Dialler menu on the keypad. 
WinTPC connects to the control panel. 

Modem connection from dialler to PC 
Before making a connection, the dialler has to be programmed with a U/D telephone 
number. See also the RD62 programming manual. 

Proceed as follows to establish a connection from the dialler to a PC: 

1. Enter U/D code 1 or 2 on the keypad to start an Up/Download connection. 
The dialler connects to the Up/Download phone number programmed in the dialler. 

2. Select ‘Answer’ from the Comm menu in WinTPC. 
 at the bottom of your screen indicates that you are connected to the control panel. 
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Modem connection from PC to dialler 
Proceed as follows to establish a connection from a PC to a dialler: 

1. Select ‘Dial’ from the Comm menu. The following window pops up: 

 

2. Enter the telephone number of the RD62 dialler you want to connect to. 
Separate the telephone number with commas or spaces. Enter the U/D account code 
programmed in the RD62 dialler. 

- or – 

Click icon           to select the map file from which to read the telephone number and 
U/D account code from the file tag. The map file must contain all necessary data. 

- or – 

Click icon           to select the customer with assigned U/D account code from the 
extended map-file list (see picture below) 

 

!    On slow machines and/or if you have a large number of map files, it may take 
a while before the U/D account code and telephone number selection is displayed as 
WinTPC must scan all map-files in the directory. 
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3. Click ‘Dial’. 

The table below describes what happens after you have clicked the ‘Dial’ button: 

Step Description 

1. WinTPC dials RD62 telephone number via modem. 

2. After number of ‘Rings before auto answer’, the dialler answers the 
incoming call. 

3. Dialler and modem wait for correct handshake signals. 

 If ... then ... 

 Handshake detected the dialler hangs up and returns a call 
to U/D telephone number 1. 
Go to step 0. 

 Handshake is not detected the dialler hangs up and does not 
return the call. 

 

4. WinTPC answers the call automatically and checks the U/D account code. If it does 
not match the programmed account code, no connection is made. A window pops up 
explaining this event. 

 at the bottom of your screen indicates that you are connected to the control panel. 
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Answering a call 

Proceed as follows to answer a call from the dialler: 

1. Make sure sound is enabled in the Options menu. 

2. When you hear a dialling tone, 
right-click  at the bottom of your screen to display the Comm menu. 
- or - 
go to the Comm menu. 

3. Select ‘Answer’ from the Comm menu. 
 at the bottom of your screen indicates that you are connected to the control panel. 

Using ‘Automode’ 

What is ‘Automode’ 
‘Automode’ enables users to receive panel and dialler information automatically. The 
modem waits for incoming calls. If an incoming call is detected, the modem answers 
automatically and starts uploading the information.  

When the uploading is completed, the information is saved to the MAP-directory. The 
modem disconnects and waits for new incoming calls. 

How to use ‘Automode’ 
Proceed as follows to connect to a control panel using ‘Automode’: 

1. Right-click  at the bottom of your screen to display the Comm menu 
- or - 
go to the Comm menu. 

2. Select ‘Automode’ from the Comm menu. 
A window pops up showing the number of incoming calls. 

Ending ‘Automode’ 
• To end ‘Automode’ simply press Cancel button on the window showing the number of 

incoming calls. 

Closing a modem connection 

• Select ‘Hangup’ from the Comm menu to close the modem connection. 
 at the bottom of your screen indicates that you have been disconnected from the 

control panel. 
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EDITING CONTROL PANEL SETTINGS 

Online and offline 

Some menu items can only be edited while there is an online connection. 
See ‘Only available online’: 

• Time and date settings 

• Installation of remotes 

• Resetting engineer log 

• Sending messages. 

��If you select a menu item in the Edit Panel Settings window, the bottom left 
corner of your screen displays its quick code. 

Adjusting date settings 

Proceed as follows to set the date: 

1. Make sure the panel is not armed. 

2. Select ‘Date’ from ‘Only available online’ menu. 
The following window pops up: 

 

3. Click the double arrows to adjust the year. 

4. Click the single arrows to adjust the month. 

5. Click the day number. 

6. Click ���� to confirm the new date settings. 
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Adjusting time settings 

Proceed as follows to set a new time: 

1. Make sure the panel is not armed. 

2. Select ‘Clock’ from the ‘Only available online’ menu. 
The following window pops: 

 

3. Enter a new time. 

4. Click ���� to confirm the new time settings. 

Sending a message to keypad(s) 

Proceed as follows to send a message to one or more keypads: 

1. Make sure the panel is not armed. 

2. Select ‘Send message to keypad’ from the ‘Only available online’ menu. 
The following window pops up: 

 

3. Type a message and select the keypads. 
The LCD display shows a preview of the message. 

4. Click ���� right above the window to send the message. 
- or - 
Click X right above the window to discard message. 
The following window pops up: 
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Click ‘Yes’ to confirm. 
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Engineer reset  

Proceed as follows to reset area engineer logs: 

1. Make sure the panel is not armed. 

2. Select ‘Eng reset’ from the ‘Only available online’ menu. 
The following window pops up: 

 

3. Select an area from the list. 

4. Check the ‘Eng reset’ checkbox. 

5. Click ���� to confirm the new settings. 

Increasing and decreasing values 

Proceed as follows to increase or decrease values: 

1. Go to Timing - Siren Timing - Bell Delay. 
The following window pops up: 

 

2. Click the arrows  
- or - 
Click the arrow buttons on your keyboard to increase or decrease the value. 

3. Click ���� to confirm the new settings. 
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Specifying holiday slots 

Proceed as follows to specify holiday slots: 

1. Go to Timing - Timeclock - Timeslot definitions - Holiday slots. 
The following window pops up: 

 

2. Click the ‘From’ button to fill Holiday Slot 1. 

3. Click the first date and enter timeslot beginning date. 

4. Click the second date and enter timeslot end date. 

5. Click ���� to confirm the new settings. 
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Programming zones 

Proceed as follows to program zones: 

1. Select Zones from the Zones menu. 
The following window pops up: 

 

2. Select a zone from the list. 

3. Specify the type of zone. 

4. Specify the area. 

5. Specify the attributes. 

6. Specify the output. 

7. For some zone types a value for a keypad is required. 

8. For some zone types a value for a time slot may be entered. 

9. Click ���� to confirm the new settings. 
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PREPARING FILES FOR DOWNLOADING 

Proceed as follows to prepare files in WinTPC: 

1. Select ‘Open’ from the File menu or click the button on the toolbar. 
The following window pops up: 

 

2. Select a ‘map’ file stored on your system and click ‘OK’. 
If set under ‘Options’, the File tag containing information on the ‘map’ file, pops up: 

 

3. Click ‘OK’ if all file information is correct. 
The Edit Panel Settings window appears: 
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4. Double-click a menu item to expand its contents. 

 

��To expand all menus, click the right mouse button and select ‘Expand all’. 

5. Select an option from the list and edit its settings in the right part of the window. 

!  Always click ���� in the upper part of the right window to save changes. 

6. Select ‘Save’ from the File menu or click the button on the toolbar to make sure that all 
changes are saved. If set under ‘Options’, the File tag window pops up. 

7. Click ‘OK’ to save changes. 
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VIEWING STATUS INFORMATION 

About status windows 

What the symbols mean 
Status windows inform you on the actual state of the control panel. They provide you with 
information on zones, areas, tampers, remotes etc. 

Status panels feature two kinds of indicators: 

Symbol Meaning 

 No problems, not activated or not installed. 

 Problem, activated or installed. 

Toggling and refreshing outputs 

Proceed as follows to toggle or refresh outputs: 

1. Right-click the output indicator. The following window pops up: 

 

2. Select ‘Toggle’ or ‘Refresh’ from the pop-up menu. 
The following window may pop up when you select ‘Toggle’: 

 

3. Click ‘OK’. The output cannot be toggled. 

Viewing the status windows 

Proceed as follows to view status information of a control panel: 

1. Make sure you are properly connected to the control panel. 

Click the status button on the toolbar. The following drop-down menu may appear, 
depending on the type of control panel used. 
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2. Select a control status from the menu. 
The panel will appear on your screen. 
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Panel status window 

The table below displays the information in the panel status window for a CD95/150 
control panel: 

Information Description 

 

The Control Status group displays: 
• Power supply problems 

• Activated sirenes (internal - external) 

• Problems with the input expander 

• Opened panel lid. 

 

The Fuses group displays the status of the 
eight fuses. 

 

The Outputs group displays the status of the 
various outputs, up to a maximum of 48 
outputs. 

Right-click the output indicator to toggle it. 

 

 

The Area Status group displays the status of 
the various areas, i.e. armed or alarm status. 
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Zones and tampers status window 

The table below displays the information in the zones and tampers status window for a 
CD95/150 control panel. 

Information Description 

 

The zones and tampers status window displays 
alarms or tampers up to a maximum of 
152 zones. 

Right-click the alarm indicator to shunt it. 

 

Shunted zones and tampers status window 

The table below displays the information in the shunted zones and tampers status window 
for a CD95/150 control panel: 

Information Description 

 

The shunted zones and tampers status window 
displays shunted alarms or tampers up to a 
maximum of 152 zones. 

Right-click the alarm indicator to shunt it. 
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Remotes status window 

The table below displays the information in the remotes status window for a CD95/150 
control panel: 

Information Description 

 

The Installed Remotes group indicates the 
installed remotes, such as keypads. 

 

The first Remote Lid Tampers group indicates 
tampers of remotes and whether they have 
been shunted or not. 

 

The second Remote Lid Tampers group 
indicates tampers of remotes and whether they 
have been shunted or not. 

 

The Faulty Remotes group indicates problems 
with installed remotes, such as keypads. 
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UPLOADING AND DOWNLOADING DATA 

Before up/downloading 

It is essential that the following items have been programmed on the keypad of the control 
panel before you can start uploading or downloading data: 

• the dialler telephone number 

• the U/D user code 1 and/or 2. 

Refer to the Programming Manual of the dialler. 

Up/download speed 

Depending on whether you have an MPI or an RD62 dialler, up/download speed will differ: 

PCB Baud rate 

MPI 9600 baud 

RD62 300 baud 
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Uploading data 

Proceed as follows to upload data from a control panel: 

1. Make sure you are properly connected to the control panel.  

2. Click the ‘Upload’ button on the toolbar. 
The Upload window pops up: 

 

3. Check all items you want to retrieve from the control panel. 

4. Click ‘OK’. The ‘Uploading’ progress bar pops up: 

 

When the data upload is completed, the following screen will pop up: 
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5. Click ‘Stay connected’ to keep modem connection open. 
- or - 
Click ‘Disconnect’ to close modem connection. 
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Uploading the engineer log 

Proceed as follows to upload the engineer log from a control panel: 

1. Make sure you are properly connected to the control panel. 

2. Click the ‘Engineer Log’ button on the toolbar. The following window pops up: 

 

3. Select ‘Upload all events’ to retrieve the entire engineer log 
- or - 
Specify a number of events to be retrieved from the control panel. 

4. Click ‘OK’. A progress bar appears: 

 

When the engineer log upload is completed, the events are displayed in a log file view.  
 

 

5. Select ‘Save as’ under Engineer Log in the File menu to rename the log file. The 
following window pops up: 
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6. Enter a distinctive name and click ‘OK’. 
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Engineer log layout 

The engineer log looks as follows after uploading: 

 

The table below gives an overview of the data displayed in the engineer log: 

Item Description 

General information 

CD150.V6 Control panel description, i.e. type and version. 

Date & time Date and time when log was uploaded. 

Account number Account number to connect to the dialler of the control panel. 

Event information 

 Month, date and time of the event. 

 Location of event. 

 Type of event. 

 Further details on users, areas or zones. 

Opening and printing an engineer log 

1. Select ‘Open’ under Engineer log in the File menu to open a previously stored engineer 
log. The following window pops up: 

 

2. Select a log file to open and click ‘OK’. 
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3. Select ‘Print’ under Engineer log from the File menu. 
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Downloading data 

Proceed as follows to download data onto a control panel: 

1. Make sure you are properly connected to the control panel.  

2. Click the ‘Download’ button on the toolbar. 
The Download window pops up: 

 

3. Check all items you want to download onto the control panel. 

4. Click ‘OK’. The ‘Downloading’ progress bar pops up: 
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ARMING AND DISARMING CONTROL PANELS 

Arming a control panel 

Proceed as follows to arm a control panel: 

1. Click the ‘Arm’ button on the toolbar. The Arm window pops up: 

 

2. Check the Arm box to arm the entire system 
- or - 
Check the Part box to arm part of the system. 

3. Click ‘Arm’ to confirm. The countdown window pops up: 

 

When countdown has finished, the indicator at the bottom of your screen turns red: . 
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Disarming a control panel 

��Note that you must disarm a control panel to make changes to control panel 
settings. 

Proceed as follows to disarm a control panel: 

1. Click the ‘Disarm’ button on the toolbar. The Disarm window pops up: 

 

2. Check the Disarm box. 

3. Click ‘Disarm’ to confirm. 
The panel is disarmed and the indicator at the bottom of your screen will turn grey: . 
- or - 
Click ‘Cancel’ to ignore. 
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WINTPC OPTIONS 

Proceed as follows to specify WinTPC settings: 

1. Click the Options menu. The following window pops up: 

 

2. Check the options you want: 

Option Description 

Show file tag after opening To display the File tag window after opening a 
previously saved ‘map’ file. 

Show file tag before opening To display the File tag window before opening a 
previously saved ‘map’ file. 

Enable Sound To enable or disable the dialling sound. 

Enable 3 min timer To enable disconnecting with the Panel if there is 
no user interaction after 3 minutes 

Belgian Panel To enable Belgian panel servicing 

German MPI attached To enable German MPI detecting. If WinTPC is 
connected to the German Panel and this tag is not 
enabled then the MPI will be NOT DETECTED. 

Map file’s path Specify the (default) directory where the map files 
are stored. The directory navigation has a tree 
structure. 

3. Click ‘Save’ to save changes. 
- or - 
Click ‘Cancel’ to ignore changes. If you don’t make any changes the ‘Save’ button is 
greyed. 

 

 

When you open or close a ‘map’ file and one of the check boxes ‘Show file tag ...’ is 
enabled, the File tag window will appear: 
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VIEWING PANEL INFORMATION 

Proceed as follows to obtain information on the control panel you are connected to: 

1. Select ‘Panel info’ from the Help menu. The following window pops up: 

 

2. Click ‘OK’ to close the Panel info window. 

3. The same Panel Info window appears when you click  button. 
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CONVERTING DOSTPC REC-FILES TO NEW MAP-
FILES 

If you were using DosTPC and have panel configuration files (files with *.rec extension) 
you can now convert this files to use them with WinTPC. WinTPC is using another, 
encrypted format of panel configuration files with *.map extension. There is special 
converting tool – application called Convrec.  

To convert your rec files to new map format you have to proceed as follows: 

1. Select Convrec icon  from the Transport PC program group. The following 
application window pops up: 

 

2. Click the edition field in the top of the window and enter path and name of the rec-file. 
You can also click “Browse” button and enter the filename and path using standard 
windows browse dialogbox. 

 

3. If you have a rec-files for the Dialler and/or MPI repeat above actions to enter file 
names and paths (Dialler and MPI rec-files are optional for conversion). 

4. When all filenames are entered click “Convert” button to start the conversion process. 
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5. After a few seconds an dialogbox appears and you have to set the path and filename 
for the map-file. 

6. Enter map-file name and click OK. 

7. Now the rec-file is converted and map-file is saved. You can leave the application 
pressing “Exit” button or convert another file as in point 2-6.    

 


